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Dobot Magician User Manual Instruction and Precautions 

1. Please refer to the Dobot Magician User Manual along with the box before using.  

2. Precautions: 

1) Power On: Please align the Dobot into the “neutral position” by making a 45° angle between 

the forearm and rear arm (shown below), press the power button, and the stepper motors will 

lock. After about 5 seconds, there will be a short sound. If the status light switches from orgnge 

to green, the Dobot is ready to use. Note that if the light turns red, it indicates that the Dobot is 

at a limited position, so please make sure the forearm and rear arm are kept in the normal range 

of motion.  

 

2) Power Off: If the status light at the bottom right of the Dobot is green, press on the power 

button to turn off Dobot. In this process, Dobot will move slowly to the “resting” position. Be 

safe and watch your hands! 

3) If the Dobot becomes unaligned with the computer, press the Reset button behind the controller 

to recalibrate. The Dobot will automatically disconnect with the computer and reset. Then you 

can reconnect it. 

4) Please turn off the Dobot completely first before plugging or unplugging external modules, 

such as Bluetooth, WIFI, Stick controller, Infrared sensor, Color sensor etc...Not powering 

down the Dobot before doing so may damage or break your Dobot! Note that only once the 

status light completely turns off, the Dobot has powered down. 

5) When packing and transporting the Dobot, please unplug the left and right motors wires located 

near the sides to avoid damage to your Dobot. 

3. Important Safety Notice： 

 Small spare parts are included, so please keep them away from children, as they are a 

choking hazard. 

 DO NOT let children play with the Dobot alone. All processes need to be monitored 

while running. After processes have finished, please turn off the equipment promptly. 

 While using the laser module, please wear protective glasses. Avoid eye or skin exposure 

to direct radiation. Keep a safe distance from the laser to avoid accidental injury. 

 When using the 3D printing module, the heating rod will produce temperatures up to 

250℃, please be careful! 

 DO NOT put hands into the operating zone while the Dobot is running. Not doing so 

runs the risk of bruising and/or pinching. 
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4. More Materials 

Follow us to get first-hand material about Dobot Magician: 

Tutorial: http://dobot.cc/tutorial/ 

Download Center: http://dobot.cc/download-center/ 

5. DobotStudio platforms: Windows XP (DobotStudio does not support using Blockly function 

and Leapmotion function in Windows XP), win7 SP1 x32/x64, win8/win10, mac osx10.10 and 

mac osx10.11, mac osx10.12. 

6. Should you have any further questions, feel free to email us at support@dobot.cc 

http://dobot.cc/tutorial/
http://dobot.cc/download-center/
mailto:support@dobot.cc
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1. Dobot Magician Driver Installation Instruction 

When first connecting the Dobot, connect the Dobot to PC through the USB port. Then, power on 

the Dobot, then the system will recognize the corressponding hardware automatically and will 

search for the correct driver and install it. However, if it fails to install, you can install it again 

manually. The installation flow chart as follows:  

 

1.1 Download CH340 driver package and install it 

There are two versions of the driver based on Windows/Linux, so please choose the 

corressponding version to your OS to download. The driver can be located at the download 

address： 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

After downloading, unzip and install the driver. The driver file is in the file attachment of root 

directory: 

 

Figure 1.1 Driver file 

 

For example, on Windows, enter into the subfolder 

CH341SER_WIN->CH341SERCH341SER. Double click SETUP.exe and install it, as follows:  

Download driver package and 
install it

Check if the equipment work 
properly or not

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
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Figure 1.2 Install driver 

 

Click Install: 

 

Figure 1.3 Click Install 

 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

12 

 Dobot Magician User Manual 

 

 

Figure 1.4 the driver was installed successfully 

1.2 Check if the equipment can work properly in the device manager 

1.2.1 Open the device manager and if you can find the corresponding COM port of “USB-

SERIAL CH340”, then it shows the driver is installed successfully. The correct installation is 

shown below: 

 

Figure 1.5 The COM port in the device management 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

13 

 Dobot Magician User Manual 

 

2. DobotStudio Operating Instructions 

The software used by Dobot Magician is DobotStudio, and you can download the latest version 

from our official website: 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

After the file successfully downloads, unzip and double click DobotStudio.exe. Then, open the 

software. The result should be as follows: 

 

Figure 2.1 DobotStudio file 

 

Figure 2.2  DobotStudio 

Note: There may be small errors when opening DobotStudio, as shown below:  

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
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Figure 2.3 An error screen when open DobotStudio 

Please right-click the DobotStudio icon and choose to run the software as administrator. 

 

1. Select the corresponding Dobot serial port, by the top left corner of DobotStudio, and click 

“Connect”. After a successful connection, “Disconnect” will be shown. When the Dobot is 

connected, the coordinate parameters will be updated on the right side of the interface as shown 

below:  

 

Figure 2.4  Connected successfully 

There are eight modules on the main software interface: 

（1）Teaching & Playback: A system to teach the Dobot how to move. It enables the Dobot to 

accomplish recorded movements by manual control. 

（2）Write & Draw: Controls the Dobot to write, draw or laser engrave.  

（3）DobotBlockly：Teaches basic programming through a puzzle interface. Intuitive and easy 

to understand. 

（4）Script: Edit scripting language to control the Dobot. 

（5）LeapMotion: Control the Dobot by gesture.  
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（6）Mouse: Control the Dobot by mouse. 

（7）LaserEngraving: Engraves images, shapes, and words through bitmap with the Dobot. 

（8）Add More: Add even more functions for the Dobot! 

 

Here we will introduce Teaching & Playback at first. 

Click Teaching & Playback, the brief introduction of each area as follows: 

 

 

Figure 2.5 The main interface of teaching & playbac 

Area 2： 

Here comes with Dobot movement area, linear mode and jog mode.  

Linear mode: Based on the body axes coordinate system X, Y, Z with the origin at the  

center of three motors. X, Y, Z is the coordinate of the center of the end platform, and  

the direction of X is perpendicular to the base forward, Y is perpendicular to the base  
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towards the left, and Z is vertical upward. R indicates the rotation of the servo joint  

relative to the coordinate frame (counter-clockwise is the positive direction).  

 

Figure 2.6 Coordinate system 

（1） Click X+,X- and Dobot will move along X in the negative or positive direction; 

（2） Click Y+,Y- and Dobot will move along Y in the negative or positive direction; 

（3） Click Z+,Z- and Dobot will move along Z in the negative or positive direction; 

（4） Click R+,R- and Dobot will move along R in the negative or positive direction. 

 

Note: 

The R-axis will move together with Y-axis during the movements, so make sure the terminal 

posture relative to the origin of coordinates stays constant.  

 

Jog mode：This movement is aimed for a single axis. Hold down the button, and the 

corresponding axis will move independently. Once the axis is maxed out, the joint will stop 

moving. Each axis has counterclockwise as the positive direction. Joint1、2、3、4 refer to base, 

rear arm, forearm and servo respectively. 
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Figure 2.7 Single axis coordinate system 

（1） Click Joint1+、Joint1- and control the Dobot base motor to rotate in the negative or 

positive direction; 

（2） Click Joint2+、Joint2- and control rear arm motor to rotate in the negative or positive 

direction; 

（3） Click Joint3+、Joint3- and control forearm motor to rotate in the negative or positive 

direction; 

（4） Click Joint4+、Joint4- and control servor to rotate in the negative or positive direction; 

Among this, the rotation range of Joint4 is ±150°. 

 

Pen/Gripper/SuctionCup/Laser： 

Through choosing the corresponding buttons, open gripper/suction cup/laser. 
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Figure 2.8 Select End Effector 

 

You can also customize the End Effector Configuration according to the relative coordinate of the 

terminal center. The central terminal is shown as follows: 

 

Figure 2.9 The central terminal 

 

Speed：Adjust the ratio bar to change the velocity ratio of the movement of the jog control. The 

movement velocity is calculated by multiplying the corresponding percentage. Click Settings in 

Area 3 to get a fast adjustment of parameters.  

 

Area 1： 
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Home：The Dobot will automatically reset to it original neutral position. When this button is pressed, 

the Dobot will rotate back to its preset home position. In this process, the Home point can be self-

defined, which will be explained in area 5. 

Emergency Stop：Automatically stops all processes. 

 

Area 3： 

New/ Open/Save：Create / Open / Save point list. 

Start/stop: Start / Stop playback motions. 

Click Start to start from the beginning. (The button will now change into Pause.) Click Pause when 

the dobot moves, and the button will change into Resume. Click Resume and it will continue to 

move.  

Loop: Set how many times the playback will loop. 

Easy/Pro：Mode switch, including offline mode and I/O settings, and refer to the detailed tutorial: 

The tutorial of advanced functions.  

Speed/Acc: Detailed parameter configuration of playback speed and acceleration. 

Settings：Set movement parameters. 

You can also set the velocity and acceleration of single joint. 

 

Figure 2.10 Parameters of single joint movement 
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Set velocity and acceleration of coordinates: 

 

Figure 2.11 Parameter settings of coordinates  

 

The height and Z limit of Jump mode: 

 

图 2.12 Jump mode settings 

 

Handhold teaching: Tick the function says, “Enable Handhold Teaching”. Then, press and hold 

down Unlock on the forearm and drag the Dobot to any position. You can save a point after letting 
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go of the Unlock button. Of course, you can save points continuously. After all the points are 

recorded, Dobot will be able to play back the programmed trajectories.  

 

图 2.13 Playback settings 

 

Area 4：Select save mode.  

1. Click +Point, you can save the current point information in area 5.  

2. PTP Point：Point mode, and three modes between saved points, JUMP、MOVJ、MOVL 

respectively. 

JUMP： From point A to point B, the trajectory is shown below, the end effector will lift   

upwards by amount of Height (in mm) and move horizontally to a point that is above B by  

Height and then move down to Point B.  

 

Figure 2.14 JUMP Mode 

 

   MOVJ：Joint movements. From point A to point B, each joint will run from initial angle to  

   its target angle, regardless of the trajectory. The motion time for all joints are the same which  
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   means all joints will start and finish at the same time.  

     MOVL：The joints will perform a straight line trajectory from point A to    

     point B.  

                       

Figure 2.15 MOVL/MOVJ Mode 

 

3. Pause Time：The pause unit of time is 1 second.  

4. CP Point：Track points, saved points between velocity and acc transmit smoothly.  

 

Area 5：Playback list that can be edited. 

To show the current endeffector coordinates, Move Mode, pause time and any other parameters, 

double click to edit every single saved point coordinate. You can also edit from the sidebar on the 

left side or press right –hand button: 

 

Figure 2.16 Right click options of the saved point list 

1. MotionStyle：JUMP、MOVJ、MOVL. 

2. X, Y, Z is the coordinate of the center of the end platform. 

3. RHead indicates the rotation of the servo joint relative to the coordinate frame (counter-

clockwise is the positive direction). 

4. PauseTime. 

5. Insert：Insert a line of saved points.  

6. MoveUp/MoveDown: Move up/Move down the line of saved point.  

7. Delete：Delete selected saved points。 

8. DeleteAll: Delete all saved points.  



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

23 

 Dobot Magician User Manual 

 

9. RunSeleted: Execute selected points.  

10. Overwrite：Overwrite current saved points.  

11. SetHome:Set as Home point location. 
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3. Teaching & Playback 

Here we will learn how to suck up or grab simple objects using the function of Teaching & 

Playback. Because we need to use the air pump kit for the suction cup and the gripper kit, we will 

introduce these two kits together. 

3.1 Air pump kit 

The default installation of the Dobot Magician is the suction cup. The pump box and 

suction cup kit is shown below: 

 

Figure 3.1 Air pump kit 

Installation Steps: 

1. Connect power line SW1 on the pump box with interface SW1 on the controller box, connect 

signal line with interface GP1; 

2. Tighten air pump kit into the end of the socket with butterfly nut; 

3. Connect windpipe on the controller box with pipe connector on the pump box;  

4. Connect GP3 of Joint4 servo line with forearm connector①GP3. 

The installation effect as follows: 

 

Figure 3.2 The installation effect of air pump kit 
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3.2 Pneumatic Gripper Kit 

1. Pneumatic accessories are shown in following picture:

 

Figure 3.3 Pneumatic Gripper Kit 

2. The gripper kit shares the air pump kit of suction cup. You can remove the suction cup from 

Joint4. Unscrew the fixed on the suction cup with the hex wrench, shown in Figure 3.4: 

 

Figure 3.4 Remove suction cup 

JackScrew 
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3. Install the gripper kit on Joint4 with the coupler, as shown in Figure 2.5:  

 

Figure 3.5 Gripper Installation 

 

4. The connection method of gripper is the same with air pump kit. You can refer to air pump kit 

method above.  

5. The installation effect of gripper kit as follows: 

 

Figure 3.6  Gripper Installation  

3.3 Demo of Teaching & Playback 

After learning about the software, now we can try to make Dobot Magician move. Through the 

function of Teaching & Playback, we can make it move a small object.  

1. Select the terminal tool as SuctionCup on the software interface and select JUMP mode.  

2. Place a small object nearby and move the Dobot above the small object. Click Area 2, tick 

SuctionCup and open the pump. The small object will be sucked up. 

3. Click +Point and save a point. 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

27 

 Dobot Magician User Manual 

 

4. Click Z+ to raise the Dobot and move the arm to another position. Place the small object on the 

table, uncheck SuctionCup, and close the pump. 

5. Click +Point and save one more point. 

6. Put back the small object and click Start. Our task for moving the object from the current 

location to another location has been completed successfully. 
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4. Advanced function of Teaching&Playback 

You can switch Easily into Pro when pressing the button “Easy/Pro”, as shown below: 

 

Figure 4.1  Advanced function of teaching&playback 

4.1 StepRun 

1. StepRun: StepRun allows you to execute one command at a time. Pressing it once executes 

the first motion, and subsequent presses will execute commands down the list one at a time. 

 

Figure 4.2  StepRun 

2. Click Stop and then you can exit the mode of StepRun. 

4.2 Offline mode 

1. Click Download to download the current saved points list into the Dobot. A USB cable will 

not be needed for use.  
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Figure 4.3 Download saved point list 

 

2. After downloading, pull out the USB cable, press Key behind the controller box, and execute 

the downloaded program. The program will stop executing when it is pressed again.  

 

Figure 4.4 Offline mode button 

 

Note: Before offline mode can be used, the Dobot needs to be reset by pressing Home. Switch on 

the Dobot, wait 20 seconds after the green light is on, and click Home when the sensor is stable. 

1) The blue light will flash during homing. It is completely normal for that to happen. Do not 

operate the Dobot until the green light is on. 

2) After homing, you can save points and then download. Click OK in the dialog box. 
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Playback steps: 

Switch on the Dobot, wait 20 seconds after the green light is on, and then click Key to move 

offline when the sensor is stable. 

4.3 EIO multiplex  

The EIO (Extended I/O) in Dobot has multiple functions and uses. This chapter aims to address all 

the functions for DobotV2.0 EIO.  

The EIO interface of advanced functions is shown below: 

 
Figure 4.5  EIO Interface 

 

4.3.1 EIO locations 

EIO are located near the base and forearm separately in DobotV2.0.  

1）EIO located in the forearm are shown below: 
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Figure 4.6  EIO addressing in forearm 

 

2）EIO located in the base 18PIN interface board are shown below: 

 

Figure 4.7  EIO addressing in base 18PIN 

 

3）EIO located in the base 10PIN interface board are shown below: 
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Figure 4.8 EIO addressing in base 10PIN 

 

4.3.2 EIO multiplex function  

Now let’s describe the EIO multiplex function. (Depending on hardware)  

1）EIO multiplex instruction of forearm interface board, as shown below: 

Figure 4.1  EIO multiplex instruction of forearm interface board  

2）EIO multiplex instruction of 18PIN interface board on the base, as shown below: 

Figure 4.2 EIO multiplex instruction of 18PIN interface board on the base  

EIO 

addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O1 3.3V √  √ √ 

O2 12V √    

O3 12V √    

O4 3.3V √ √ √  

O5 3.3V √  √ √ 

O6 3.3V √ √ √  

O7 3.3V √  √ √ 

O8 3.3V √ √ √  

O9 3.3V √  √ √ 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

10 5V √    

11 3.3V √ √ √  

12 3.3V √  √ √ 

13 5V √    

14 3.3V √ √ √  

15 3.3V √  √ √ 

16 12V √    

17 12V √    
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3） EIO multiplex instruction of 10PIN interface board on the base, as shown below:  

Figure 4.3  EIO multiplex instruction of 18PIN interface board on the base  

 

4.3.3 EIO multiplex Demo 

Selected corresponding EIO, set input/output condition, and then you can multiplex each unique 

EIO. Here we have detailed explanation of level output, level input, ADC input and PWM output.  

1） Level Output 

Take EIO01 on the forearm connector for an example, it can configure level output into 3.3V. Shown 

as follows: 

 

Tick IO_1(in the output option) -> tick Value, -> +Point, and then it can be configured into 

high-level output of 3.3V(If you don’t tick it, please choose low-level output).  

 

 

Figure 4.9  High level output of EIO1 demo 

2） Level input 

Also, take EIO01 on the forearm connector for an example, if you get an external photoelectric 

sensor, it will trigger Dobot move and can be configured into low/high level input trigger mode 

when access to an inductive object. Select trigger point->EIO1_Input (Trigger area on the 

bottom right)-> Condition=1->add ADD key. Cancel key can delete trigger settings of the 

current point. Trigger Value=0 denotes a low level and Value=1 denotes a high level. 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

18 3.3V √  √  

19 3.3V √  √  

20 3.3V √  √  

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O1 3.3V √  √ √ 
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Figure 4.10 High level output of EIO1 demo  

 

3） ADC input 

ADC input operational method is the same with level input. Select configured saved point and pins 

of the ADC (such as EIO1), set ADC value less than 200, and click ADD key to finish. The trigger 

value settings range is from 0 to 4095. 

 

Figure 4.11  EIO1  ADC input demo 

 

4） PWM Output 

PWM: Take EIO4 for a demo 

 

Tick IO_4 pin in the Output area, click +Point to save new points, double click EIO4 table cell, 

select “…” in the drop-down box, and set Frequency, unit of KHZ，10HZ-1MHZ and 

DutyRatio（0-100%) in the pop-up dialog, as shown below: 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O4 3.3V √ √ √  
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Figure 4.12 EIO4  PWM output demo 

 

Above is the four multiplex demo. 
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5. Write & Draw Manual 

The whole flow chart as follows: 

 

5.1 Installation of writing accessories 

A pen and pen holder included in the Write & Draw kit. The steps to install are as follows: 

1. Install the pen into the fixture; 

2. Lock the fixture into the end-effector with butterfly nut. 

 

Figure 5.1   Installation of pen 

 

If you want to change the pen, just loosen the four screws on the pen holder. 

 
Figure 5.2 Pen installation 

Pen 
Installation

Connect 
DobotStudio

Import 
pictures and 
set params

Adjust the 
position and 

start to write
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5.2 Connect DobotStudio 

1. The software used by Write & Draw is DobotStudio, and the hardware itself is applicable for 

DobotStudio, so you can connect it directly. Open the software and click the Write & Draw 

module. The interface of Write & Draw is shown below: 

 

 

Figure 5.3 Writing & drawing interface 

 

2. If the current hardware is not the hardware of Write & Draw itself, there will be a pop up to 

change the firmware. For example, if the current firmware is for 3D printing, there will be a 

pop up for a selected window. Here, we can choose DobotStudio in the drop-down box:  



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

38 

 Dobot Magician User Manual 

 

 

 

Figure 5.4 Select DobotStudio 

 

Then click OK. A pop up window will ask to burn hex. Click Confirm to do so: 
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After burning, DobotStudio will be opened automatically. Also, after about ten seconds, you will 

hear a short sound from the built-in buzzer, which shows a successful burning. At the same time, 

the light on the bottom right will also turn green. Finally, we can connect Dobot according to the 

above operation.  

5.3 Import pictures and set parameters  

1. The imported picture should be put into the sector area of the main interface, as Dobot will be 

at a limited position if beyond the standard range of motion because of unnatural writing. 

There will be a warning of a red highlighting if beyond range.  

1） Click Open, and import the ready PLT or SVG file:  

 

Figure 5.5 Open the file 

 

2） Insert the included pictures of DobotStudio; 
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Figure 5.6 Insert the included file 

 

3） Input text manually;  

 

Figure 5.7 Input text manually 

 

4） You can also import pictures. You need convert these formats（BMP/JPEG/JPG/PNG and so 

on） into SVG (the format recognized by Dobot).  
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Figure 5.8 Import pictures 

 

After opening the picture, adjust the image to desired size and click Convert Bitmap. The SVG 

path file will come out automatically. Then, click Plot to Main Scene, and the file will be loaded 

in writing main interface, as shown below: 

 

Figure 5.9 Import pictures into SVG files 

2. Set writing parameters: set velocity and acceleration(0~500mm/s) and PenUpOffset;  
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Figure 5.10 Set velocity and acceleration 

5.4 Adjust the position and start writing  

1. Set endeffector as Pen. Here, you can choose from Settings->EndEffector, as shown below:  

 

Figure 5.11 Set EndEffector 

 

2. Adjust the nib position: press and hold down Unlock key on the forearm and drag the 

forearm to make the nib contact to paper. Also, you can control Z axis moving down to paper 

gradually, shown as follows:  
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Figure 5.12 Adjust the nib position  

 

3. Click AutoZ and get the current Z value. This is so you don’t need to adjust the nib position 

when you write next time. Then, follow these steps: import pictures-> SyncPos->Start to 

start. 

 

Figure 5.13 Lock writing height 

 

You can check the PenDown parameter from here:  
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Figure 5.14 Pendown parameters 

 

If the writing is not very clear, the nib height may need to be adjusted slightly. Revising the value 

of Pendown may also help.  

4. Click SyncPos and the Dobot will move into the top position of writing starting point 

automatically.  

5. Click Start, Pause and Stop to control Dobot. 

6. The result is shown below: 

 

Figure 5.15 The effect of writing 
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6. Laser Engraving 

The entire process of laser engraving is as follows: 

 

Notice: 

Laser engraving and shade laser engraving are different functions. The firmware and upper 

computer used by laser engraving are the same as the ones used in Write & Draw, which can only 

engrave pictures that are composed of a single line. However, shade laser engraving can achieve 

the function of bitmap engraving .(For example, it can engrave figures and head portraits.) If you 

want to use the function of shade laser engraving, please refer to Dobot2.0 Shade Laser 

Engraving. 

6.1 Laser Installation 

1. Fasten the laser by butterfly nut; 

2. Connect 12V power line with interface ⑤SW4 and connect TTL control line with interface 

③GP5. 

 

Figure 6.1  Install Laser 

6.2 Connect DobotStudio 

1. The software used by laser engraving is DobotStudio, so please open the software, click Write 

& Draw, and enter into laser engraving interface, as shown below:  

laser installation
Connect 

DobotStudio

Import Pattern 
and Set 

Parameters

Adjust focus 
and

start to engrave
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Figure 6.2 Laser engraving interface 

 

2. If the current firmware is not for laser engraving, for example, if it is for firmware 3D printing, 

then a pop up dialog will give the option to choose DobotStudio in the drop-down box: 
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Figure 6.3 Connect DobotStudio 

 

Click OK aand a window will pop up asking to burn hex. Click Confirm to burn hex: 
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After burning, DobotStudio will be opened automatically. Also, after about ten seconds, you can 

hear a short sound from built-in buzzer, which shows a successful burning. At the same time, the 

light on the bottom right will turn into green. We can then connect Dobot according to the above 

operation.  

6.3 Import pictures and set parameters 

1） The imported laser engraving file should be put near where the Dobot arm is, as the Dobot 

will be at a limited position if beyond the standard range of motion. There will be a flashing 

red light to warn you if the arm is beyond its natural range.  

2） Click Open, and import the ready PLT or SVG file:  

 
Figure 6.4 Open PLT File 
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3）  Insert the included pictures of DobotStudio;  

 

Figure 6.5 Insert included pictures 

 

4）  Input text manually; 

 

Figure 6.6 Input text manually 

 

5） You can also import pictures. You need convert these formats (BMP/JPEG/JPG/PNG and so 

on) into SVG (the format recognized by Dobot).  
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Figure 6.7 Import pictures 

 

After opening the picture, set proper switching threshold, click Convert Bitmap. The SVG path 

file will come out automatically. Then, click Plot to Main Scene and the file can be loaded in 

writing main interface, as shown below:  

 

Figure 6.8 Import pictures and SVG path file will come out automatically 

 

1. Set laser engraving parameters: set velocity and acceleration(suggested value is 3 ) and 

PenUpOffset. On here, just keep the default 20; 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

51 

 Dobot Magician User Manual 

 

 

Figure 6.9 Set parameters of laser engraving  

6.4 Adjust the focus and start writing 

1. Select the EndEffector as Laser, shown as follows: 

 
Figure 6.10 Set EndEffector 

 

2. Tick ON on the Operation Panel to open the laser; 
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Figure 6.11 Open the laser 

 

Focus Adjustment: Hold down the Unlock Key to adjust the distance between laser and the 

surface of the material, and then adjust the knob to focus it properly. It will be at the right height 

when the laser dot burns the brightest. Burn marks on the paper will be another indicator that you 

have done so correctly. You can turn off the laser by unticking the box after adjusting.  

 

If it still cannot focus, then the focus of the laser is wrong. We can rotate the metal knob of the 

laser to adjust (as shown on the bottom right) and refocus again.  

 

Figure 6.12 Focus Adjustment 

Notice： 

The laser can heat objects when it is in a focused state, so objects like paper or wood can 
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be engraved or burned. 

! DO NOT focus the laser on people or animals 

! DO NOT let children play with it alone.   

! The process needs to be monitored when it is running. 

! After the process, please turn off the laser promptly. 

3. Click AutoZ and get the current Z value. This way, you do not need to adjust the focus 

manually when you engrave next time. To do so, here are the steps: import pictures-> 

SyncPos->Start. 

 

Figure 6.13 Lock writing height 

You can check the Pendown parameter from here: 

 

Figure 6.14 Pendown parameters 
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If the engraving isn’t clear, the laser height needs to be adjusted slightly. Revising the value of 

Pendown also helps. 

4. Click SyncPos, Dobot will move into the top position of the starting point automatically.  

5. Click Start, Pause and Stop to control Dobot. 

6. The effect shown as follows: 

 

Figure 6.15 The product of laser engraving 
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7. The Tutorial of Shade Laser Engraving 

The whole flow chart of shade laser engraving is shown below: 

 
Note: Shade laser engraving is also a kind of laser engraving! 

7.1 Installation of Laser Accessories  

Shade laser engraving and laser engraving share the same kit. Please refer to the chapter pertaining 

to laser engraving installation. 

7.2 Connect DobotStudio 

1. Open DobotStudio and select the EndEffector as Laser. 

 

Figure 7.1 Open laser engraving interface 

Installation 
of Laser 

Accessories

Connect Grbl 
Controller

Import Pattern 
and Set 

Parameters

Start 
Engraving
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Figure 7.2 Enter the shade laser engraving interface 

 

2. If the current firmware is not for DobotStudio, (for example, 3D printing) a pop up window 

will ask for you to switch. Then, we can select DobotStudio in the drop-down box:  

 

Figure 7.3 Select DobotStudio 

 

Then click OK, and a window will pop up asking to burn hex. Click Confirm to burn hex: 
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After burning, DobotStudio will open automatically. Also, after about ten seconds, you can hear a 

short sound from built-in buzzer, which shows a successful burning. At the same time, the light on 

the bottom right will turn into green. We can then connect Dobot according to the above operation.  

7.3 Import Pattern and Set Parameters 

1. The imported picture should be put into an area near the Dobot’s arm, as it will be at a limited 

position if beyond the standard writing range. If the Dobot is out of reach, then a red light will 

flash.  

You can also import pictures. Convert these formats (BMP/JPEG/JPG/PNG and so on) into 

SVG, which is recognized by Dobot.  

 

Figure 7.4 Import engraving pictures 

Open the picture, adjust the gray scale(0-255), laser power(0-100%) and the border for the 

customized engraving effect. 
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Figure 7.5 Import the pictures into SVG file 

2. Set shade laser engraving velocity and acceleration, here we suggest 5, as shown below: 

 
Figure 7.6 Set the parameter 

7.4 Adjust Focus and Start to Engrave 

1. Set the endeffector as Laser, as shown below:  
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Figure 7.7 Set EndEffector  

 

2. Focus adjustment. Adjust the distance between the laser and engraving material and check ON 

to open the laser. 

 

Figure 7.8 Check the laser 

Focus Adjustment. Hold down the Unlock Key to adjust the distance between laser and the 

surface of the material, and then adjust the knob to focus it properly. It will be at the right height 

when the laser dot burns the brightest. Burn marks on the paper will be another indicator that you 

have done so correctly. One can cancel ticking to close laser after adjusting.  
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Figure 7.9 Focus adjustment 

Notice： 

The laser can heat object when it is in focused state, objects like paper board or wood 

can be engraved or burned. 

! DO NOT focus the laser on people or animals 

! DO NOT let children play with it alone.   

! The process needs to be monitored when it is running 

! After the process, please turn off the laser promptly  

 

3. Click AutoZ to set the current Z value, and then follow these steps: import 

pictures->Synchronous->Start) 

 

Figure 7.10 Lock the height 

Saved value of Z, check from here: 
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Figure 7.11  Check the height 

If the engraving isn’t clear, the laser height needs to be adjusted slightly. Revising the value of 

Pendown also helps. 

4. After focus adjustment, click SyncPos. The Dobot will move to the start position. 

 

5. Click Start, Pause and Stop to control the Dobot. 

6. The result is shown below:  
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Figure 7.12 The Engraving Effect 
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8. The Tutorial of 3D Printing  

The whole flow chart of 3D printing as shown below:

 

3D printing can use Repetier Host and Cura: 

 Cura: Slicing is fast and stable, has strong inclusiveness to 3D model structure, less parameter 

settings, more users.  

 Repetier-Host: It can slice, check and modify G-Code, and control 3D printing manually. While 

it doesn’t offer built in slicing, it can use 3rd party slicing software, such as CuraEngine, Slic3r 

and so on. Finally, it has more parameter settings, making it very flexible.  

Here will introduce the details separately from the second step. 

Note: On Mac OS, Dobot can only use Cura, please refer to the tutorial of Cura.  

8.1 Installation of Accessories of 3D Printing 

3D printing accessories: extruder, hotend, motor cable and filament, as shown below: 

 

Figure 8.1 Accessories of 3D Printing 

 

The steps as follows: 

1. Press down the lever on the extruder by hand, and push down the filament to the bottom of the 

hole via the pulley.  

Accessories 
Installation of 
3D Printing

Connect 
Repetier Host

Preparation 
before Printing

Import Models 
and Start to 

Print



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

64 

 Dobot Magician User Manual 

 

 

Figure 8.2 Insert filament  

 

2. Insert the filament to PTFE Tube and push it down the bottom of the hotend, then tighten the 

Push-in fitting on the extruder. Notice: Make sure the PTFE Tube itself is pushed down to the 

hotend bottom. Otherwise, it will cause abnormal discharge.  

 

Figure 8.3 Connect extruder and hotend 
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3. Fasten hot end with butterfly nut;  

4. Connect power line of heating cable with interface 4 on the forearm, link power line of fan 

with interface 5, and connect thermistor line with interface 6. 

 

Figure 8.4 Connection of forearm 

5. Connect extruder motor line with Stepper1 on the controller. 

 

Figure 8.5 Connection of extruder  

6. The whole kit should look like this: 

 

Figure 8.6 3D printing installation 
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8.2 Repetier Host 

8.2.1 Switch into 3D printing 

Repetier host has been built into DobotStudio. Open DobotStudio, click Tools-> Open 3D 

Printing： 

 

A pop up a dialog of 3D printing burning firmware will appear. Click Confirm, and then Repetier 

Host will pop up automatically, as shown below: 

 

The interface of Repetier Host:  
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Figure 8.7 Repetier host 

 

Note: If the current software is set for 3D printing, you can open DobotStudio directly when you 

want to use next time. Click Connect, select Ok, and then you can switch to Repetier Host, as 

follows:  

 

Figure 8.8 Switch into 3D printing automatically 
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8.2.2 Parameter Settings of 3D printing for the first time  

Set this up when you use it for the first time ONLY. (You don’t need to do this twice!) 

Click ‘Printer settings’ in the top right corner of the interface, and set related parameters in the 

pop up diaglogue box:  

（1）Connection lable settings 

Printer Name: Dobot ( can be named by oneself) 

Select Dobot Serial Port: Dobot serial port 

Baud Rate: 115200 

Reset on connect:DTR low->high->low 

Reset on Emergency：Send emergency command+DTR high->low( If failed to connect, please 

try other options ) 

Receive cache size: 63 

The rest keep the default settings, click Apply after setting. 

 

Figure 8.9 Connection Settings 

 

（2）Connection Lable Settings 
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uncheck the following three settings and keep the rest default: 

 

Figure 8.10 Printer settings  
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（3）Extruder Settings 

The number of extruder setting: 1 

 The nozzle diameter: 0.4mm 

 Keep the rest default. 

 

Figure 8.11 Extruder Settings 

 

（4）Printer Shape Settings 

Select circle printer and the detailed parameters as follows: 

Home X： Min 

Home Y： Min 

Home Z： 0 

Print area radius:  80mm 

Print area height:  150mm 

Click Apply after setting. 
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Figure 8.12 Printer Shape Settings 

 

After setting parameters, return to the main interface. Open the Dobot main power supply, insert 

USB, and click Connect at the top left corner of main interface. Then, we can connect Dobot. The 

LED will turn green and the temperature will be shown below the interface: 
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Figure 8.13 Connect Dobot 

 

8.2.3 Preparation before Printing 

We need to melt the plastic to be able to have it flow properly, so we first heat the extrusion head. 

Here, set heating temperature to 200℃ and then click the heating button  on the control 

panel to heat it. s 

Notice： 

The heating rod will produce high temperature up to 250℃, so please be careful！ 

DO NOT let children play with it alone.  

The process needs to be monitored when it is running.  

After the process, please turn off the equipment promptly.  
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Figure 8.14 Heat the Extrusion Head 

 

When the heating temperature is up to 200℃, click the extruder feeder and feed up to 10-30mm, 

as shown below: 

 

Figure 8.15 Extrude filaments 
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If melted materials flows from nozzle of the extruder, then it means the extruder is working 

properly: 

 

Figure 8.16 Filament Extrusion 

Note: If the filament extrusion is in the opposite direction, simply remove the filament, turn the 

extruder around, and replace the filament.  

 

Figure 8.17 Reverse installation diagram of the extruder 

 

8.2.4 Adjust the printing space and get printing coordinates 

During printing, if the distance between the nozzle and print is too large to paste the print bed of the 

first layer or if the distance is too small, which will cause a blockage, we need to adjust the proper 

distance for smooth printing. Generally, the thickness of a sheet of paper is OK so paste a layer of 

masking tape on the glass print bed in order to have the first layer printed adhere better.  
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Figure 8.18 Masking tape 

 

Adjustment process: Press the Unlock key on the forearm and drag the printing head to contact the 

surface of the masking tape. Then, press “key” at the base of the Dobot to save the current Z value 

(or insert M415 in the command line, enter and get the current Z value).   

Notice: 

After sending M415 or press “KEY”, Dobot will get current coordinates, if it is successful, you will 

hear a beep. Also, you don’t have to insert the command next time when printing. 

The window of command is shown below： 

 

Figure 8.19 Sending out M415 command 
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If you cannot find the command line window, please close Easy mode, as shown below: 

 

 

8.2.5 Import Model  

The file format of 3D printing is STL, which is employed universally.  

Users can build one’s own 3D model and transfer it into a STL file, or search for free models to 

import them directly. Click open, import 3D model file (in STL format), as shown below: 
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Figure 8. 20 Import Models 

Model Center/Scale: Users can operate the model to place in the middle, zoom or rotate and any 

other functions.  

 
Figure 8.21 Model Center/Scale 

8.2.6 Set slice parameters and slice up 

Select slice engine Slic3r and click Configuration to set slice parameters. 
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Figure 8.23 Main interface of parameter settings 
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Its important to set slice parameters, so users should get the best slice parameters according to 

printed models and tested performance of the equipment. Here we suggest a configuration file that 

can be impoted from attachement of DobotStudio:  

 

图 8.24 Config files 

 

Dobot-2.0-Vase.ini is used for printing a thin-valled vase, while Dobot-2.0.ini is used for filling, 

(the filling rate is 15%).  

Import the file after downloading: Click File->Load configto load.ini file. 

http://www.dobot.cc/其中Dobot-2.0
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Figure 8.25 Import configuration file 

 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

81 

 Dobot Magician User Manual 

 

After importing the file, users need to save the three labels: Print settings, Filament settings and 

Printer settings. Users can rename them, but the default names are recommended for clarity:  

 

Figure 8.26 Save configuration file 

 

Slice: After finishing above settings, save the settings of each label, and return to main interface. 

Select slic3r, import slice settings and click Slice with Slic3r.io   
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Figure 8.27 Finish slice 

 

8.2.7 Start to Print  

Now, click Start print at the top left corner of main interface to print： 
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Here we choose vase mode, and the product after printing as follows:  
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Figure 8.28 The Product of Printing 
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8.3 Cura Introduction for 3D printing 

If you want to use Cura for 3D printing, the details seen as follows: 

Notice: Installation of accessories and firmware burning shown as Repetier Host 3D printing.8.2 

Repetier Host 

8.3.1 Cura parameter settings 

Cura is a free software that can be downloaded on its official website. We recommend you to use 

Version V14.07. You can download the software here:  

https://ultimaker.com/en/products/cura-software/list 

The software interface is as follows: 

 

Figure 8.29 Cura interface 

 

Machine->machine settings, set related parameters in the pop-up dialog: 

（1）Connection label settings 

maximum width：80mm  maximum depth：80mm maximum height：150mm； 

Machine center 0,0：Need tick 

Build Platform shape: Circular 

COM port setting: The corressponding COM port in the device management 

Baud rate：115200 

You can also choose to change the machine’s name. Keep the rest of the default settings and click 

OK after finishing. 

https://ultimaker.com/en/products/cura-software/list
javascript:void(0);
javascript:void(0);
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Figure 8.30 Machine settings 

 

（2）Import configuration file 

It is vital to set slice parameters so users should get the best slice parameters according to printed 

models and tested performance of equipment. Here we suggest a configuration file that can be 

impoted from attachment of DobotStudio:  
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Figure 8.31 Configure files 

 

Dobot-2.0-Vase.ini is used for printing a thin-valled vase, while Dobot-2.0.ini is used for the 

filling. (The filling rate is 15%.)  

Import the file after downloading: Click File->Load Profile. 

 

http://www.dobot.cc/其中Dobot-2.0
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Figure 8.32 Import configuration settings 

 

For more detailed printing parameters, go to the Cura website! 

（3）Open the model and connect Dobot 

Click Load, import a 3D model, and Cura will slice up automatically. You can also select different 

modes in the drop-down list located on the right to check if its trajectory is correct or not:： 
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Figure 8.33 Import a model 

 

Click the model to operate it. You can place it in the middle, zoom or rotate, as well as other 

functions.  
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After importing a model, Print with USB on the main interface will be activated. Click it to 

connect to Dobot automatically. The screen will show the current printing temperature on the top 

corner of the window. At the same time, the Printing key will be activated, as shown below:  

 

Figure 8.34 Connect Dobot 

8.3.2 Preparation before Printing 

Before printing, test the function of the extruder. Test to see if the filament flows in and out and if 

the direction of the filament is in reverse. Set the heating temperature to 200℃ and then press 

enter to heat the nozzle.  

Notice： 

The heating rod will produce high temperatures up to 250℃, please be careful！ 

DO NOT let children play with it alone.  

The process needs to be monitored when it is running.  

After the process, please turn off the equipment promptly.  
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In the heating process, the fan will turn on automatically. When the heating temperature is up to 

200℃, click the feedstock extruder and feed up to 10-30mm, as shown below:  

 

 

If melted filament flows from the nozzle of the extruder, then it means the extruder is working 

properly: 
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Figure 8.35 Filament Extrusion  

Note: If the filament extrusion is in the opposite direction, simply remove the filament, turn the 

extruder around, and replace the filament.  

 

Figure 8.36 Reverse installation diagram of the extruder 
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8.3.3 Adjust the printing space and get printing coordinates  

Note: For more detailed steps, please refer to the above chapter Repetier Host. 

 

Figure 8.37 Distance adjustment 

8.3.4 Start printing 

Just click Print, and then start printing. 
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Figure 8.38  Start printing 

 

Note: During the printing, if the distance between the nozzle and print is too large or too small to 

paste the print bed of the first layer, there may be a blockage. We need to adjust the proper 

distance for smooth printing. If it is not proper height when printing the first layer, we can change 

the parameters in the initial-layer thickness. (For example, -0.1mm or +0.1mm.) After fixing it, 

Cura will slice the model automatically.Then you can test the print again. After testing, the default 

heught of first layer is 0.87mm. 

 

Figure 8.39 Amend the height of first layer 
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Here we choose vase mode, and the product after printing as follows:  

 

Figure 8.40 The Product of Printing 

 

8.3.5 Text note 

Parameters Introduction of 3D printing 

Here we only introduce necessary parameter settings, and one can review the related links about the 

rest parameters: http://manual.slic3r.org/ 

（1） Printer settings 

Set the height of print layer: 0.2mm； 

The height of first layer: 0.35mm； 

http://manual.slic3r.org/
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Spiral vase: Check this one and click Yes. Then we can print unfilled vase.
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The fill rate settings: 

 

If users need print support, please tick Generate support material: 

 

The speed settings: 
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（2） Filament settings 

Consumable diameter: 1.75mm 

       The temperature: 200℃ 
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Open the fan: 

 

（3） Printer settings  

The number of Extruder: 1 

The nozzle Z offset of extruder: 0mm 

Notice: If the height of nozzle is so large that consumables cannot paste onto the print bed 

or so small that it cannot discharge when printing the first layer, users can amend the 

height from this interface, such as -0.01mm or +0.01mm, thus, one need not adjust the 

height again.  
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G-code Settings: 

Start G-code: M106 

End G-code:  

M104 S0 ; turn off extruder 

G91      ;relative positioning 

G1 E-1 F300   ;retract the filament a bit before lifting the nozzle 

 to release some of the pressure 

G1 Z+3 E-5 F{travel_speed}    ;move Z up a bit and retract filament even more 

G1 Y+50 

G90   

M107 
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The nozzle diameter settings: 0.4mm； 

The pump back speed settings: length=6 mm，speed=60 mm/s. 

 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

102 

 Dobot Magician User Manual 

 

9. Base Calibration and Sensor Calibration 

9.1 Base Calibration 

Dobot Magician has been carefully calibrated before being shipped out. If the home position isn't 

in the middle when you use the Dobot(errors between 1°-2°is in the allowable range), it needs 

to be re-calibrated.  

 

1. Put Dobot in the marked place, as shown below. 

 

1. Figure 9.1 Put dobot in the marked place 

2. Open Dobot Studio, click Tools, and choose Base Calibration, as shown below: 
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Figure 9.2 Base Calibration 

3. Click Next, and Dobot will begin auto-homing. You can do the next step when the button 

changes from grey to white. 

4. You need to fine tune the home position through +J1 and -J1 before clicking Calibration. put 

the nib in the line between A3 and B3, as shown below. 
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Figure 9.3 Base Calibration 

5. Click Calibration, the Base Calibration will be finished. 
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9.2 Sensor Calibration 

If you find the pen faces upward paper during writing & drawing or 3D printing, the sensor needs 

to be calibrated. (The Dobot Magician has been carefully calibrated before shipping out. You don’t 

need to re-calibrate it before using it.) 

1. Put Dobot on the marked place, shown as below. 

 
Figure 9.4 Put dobot in the marked place 

2. Open Dobot Studio, click Tools, and choose Sensor Calibration, shown as below. 

Notice: Don’t calibrate the sensor until all end effectors are removed! 
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Figure 9.5 Sensor Calibration 

3. Click Next, and the Dobot arm will carry out a preset action to compensate for the 

sensor coefficient of the front arm and rear arm. 

 

Figure 9.6 Sensor Calibration 

4. Click Next when the operation interface appears the instructions, shown as below. 

 
Figure 9.7 Sensor Calibration 
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5. Continue to click Next. 

  

Figure 9.8 Sensor Calibration 

6. Follow the instructions to calibrate sensor they appear and then click Next. 

 

Figure 9.9 Sensor Calibration 

After fine tuning, the nib should be in the center of A3, as shown below.  

 

Figure 9.10 Sensor Calibration Board 

7. Follow the instructions below, then click Next. 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

108 

 Dobot Magician User Manual 

 

 

Figure 9.11 Sensor Calibration 

Do not touch the Dobot. Use the motion button and move Dobot to 2nd calibration position and 

fine tune it. Click Next when the nib is in the center of B3. Shown as below: 

 

Figure 9.12 Sensor Calibration 

8. The distance between A3 and B3 is 80mm, so you don’t need to change the distance. Continue 

to click Next. 
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9. Click Ok to finish sensor calibration. 

 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

110 

 Dobot Magician User Manual 

 

10. Bluetooth Kit 

10.1 Bluetooth module is included in this kit, and the installation shown as follows: 

 

Figure 10.1  Bluetooth module installation 

 

10.2 Switch off the Dobot and plug the Bluetooth module into the communication interface. After 

installation, power on the Dobot and you will hear three short beep sounds. This means the 

Bluetooth module has been installed. At this time, a blue light is on and a green light is flashing. 

10.3 Turn on bluetooth on your phone (IOS), and then open the Dobot App to connect the Dobot 

arm . 

You can refer to the detailed tutorial on Youtube: 

https://www.youtube.com/watch?v=kyeXwuf17IY 

 

Notice: Please make sure Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, Color 

sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status indicator 

light is off is when the Dobot is powered down. 

https://www.youtube.com/watch?v=kyeXwuf17IY
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11. WIFI Kit 

The WIFI kit contains a WiFi module. Connect it into Dobot extensible port and use the USB 

cable to connect the Dobot together with your PC, as shown below:  

 

Figure 11.1  WiFi module 

 

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, Color 

sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status indicator 

light is off is when the Dobot is powered down. 

 

11.1 Set Dobot WiFi module 

When first using the WiFi module, you need connect the USB to configure the WiFi module. This 

is to create a virtual serial port. After setting it up, you can use the WiFi module alone without the 

USB cable. 

1. Open DobotStudio, Click Connect->Tools->Wi-Fi, and enter into the parameter setting 

interface. 
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2. Input related parameters of WLAN. 

 

Figure 11.2  Wi-Fi interface 

 Fill in Wifi name at “SSID” input box; 

 Fill in Wifi password at “Password” input box; 

 If you want to use function of DHCP, please tick checkbox; 

 Otherwise, fill in“IPAddress”、“Netmask”、“Gateway”、“DNS” and any other 

parameters. 

Generally, use DHCP. Click OK to finish setting up. Wait several seconds, and the green indicator 

of the Dobot WiFi wireless module will be on, which means that the Dobot has been connected with 

WLAN.  
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Figure 11.3 Connected with WLAN 

Then you will find out the IP address, located on the main interface of DobotStudio as shown below: 

 

Figure 11.4 Dobot IP address 

Select the address, click Connect, then you can control the Dobot through WiFi. On future uses,  

just insert the WiFi module and connect the Dobot through the address. 
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12. Stick controller kit 

12.1 GameSir Joystick Instruction 

1. The Stick controller kit includes a gamepad and USB Host module. Connect wireless module 

into the 10pin communication port behind the controller. There are two ways to connect, wired 

and wireless, shown as follows: 

 

Figure 12.1 Installation of stick module 

2. For wireless mode: (Before starting, make sure to install the module first!) When syncing the 

gamepad, the green LED will light up and you will hear 4 short beeps. This means that the 

gamepad has finished initializing. At the same time, press the button Home and A to start up the 

gamepad.  

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, Color 

sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status indicator 

light is off is when the Dobot is powered down. 

 

Figure 12.2 Start up the stick 

Now, the front button LED will turn on, and the LED beneath will flash: 
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Figure 12.3 Stick at work 

3. There are two way to use the gamepad, Linear mode and Jog mode, which can be switched by 

button L1/R1(L1 refers to jog mode and R1 refers to linear mode).The control mode details are 

shown below: 

（1） Linear mode 

Function Corressponding buttons 

Turn on stick Hold down Home and A for 2 seconds 

Turn off stick Hold down Home for 2 seconds 

Dobot X+/X- Left Stick: front/back 

Dobot Y+/Y- Left Stick: left/right 

Dobot Z+/Z- Right Stick: front/back 

Joint4 servo rotation R+/R- Right Stick: left/right 

Suction cup ON Y key 

Gripper ON X key 

Release suction cup/gripper B key 

Chart 12.1 Linear mode 

（2）Jog Mode 

Function Corressponding buttons 

Turn on stick Hold down Home and A for 2 seconds 

Turn off stick Hold down Home for 2 seconds 

Dobot Joint1+/ Joint1- Left Stick: front/back 

Dobot Joint2+/ Joint2- Left Stick: left/right 

Dobot Joint3+/ Joint3- Right Stick: front/back 

Joint4 servo rotation R+/R- Right Stick: left/right 

Suction cup ON Y key 

Gripper ON X key 

Release suction cup/gripper B key 

Chart 12.2 Jog mode 
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12.2 Beitong Joystick Instruction 

The Beitong joystick kit includes a joystick, USB Host, charger, and a wireless receptor. 

 

Figure 12.4 Joystick Module 

 

1. Before plugging in the charger into the Dobot Magician, Connect the USB Host with the Dobot 

Magician via the 10pin communication interface on the back of the unit.  

 

Figure 12.5 Installation of Beitong Joystick 

2. Plug the charger and turn on the Dobot Magician. When the installation is finished, the green 

light on the USB Host will turn on and four short sounds will be heard, which means the 

initialization is completed. Press the Logo button on the joystick and it will start. 
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Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, Color 

sensor, etc. Otherwise, you risk damaging the Dobot! Remember that only until the status indicator 

light is off is when the Dobot is powered down. 

 

Figure 12.6 Start Joystick 

 

The red light between the left bar and the right bar will flicker. 

 

Figure 12.7 The operating Joystick 
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3. You can control the Dobot arm through the joystick. There are two control modes: Linear 

Mode and Jog Mode (LB refers to jog mode and RB refers to linear mode). They can be easily 

switched through the corresponding keys on the Joystick. 

The instructions are shown below: 

(1)Linear Mode 

Function Corresponding buttons 

Turn on Joystick Press the Logo Key for 3 Seconds 

Turn off Joystick Auto Turn off 

Dobot X+/X-  Left Stick: front/back 

Dobot Y+/Y-  Left Stick: left/right 

Dobot Z+/Z-  Right Stick: front/back 

Joint4 servo rotation R+/R- Right Stick: left/right 

Suction Cup ON Y key 

Gripper ON X key 

Release Suction Cup/Gripper B key 

Chart 12.3 Linear Mode 

(2)Joy Mode 

Function Corresponding buttons 

Turn on Joystick Press the Logo Key for 3 Seconds 

Turn off Joystick Auto Turnoff 

Dobot Joint1+/Joint- Left Stick: front/back 

Dobot Joint2+/ Joint2- Left Stick: left/right 

Dobot Joint3+/ Joint3- Right Stick: front/back 

Joint4 servo rotation R+/R- Right Stick: left/right 

Suction Cup ON Y key 

Gripper ON X key 

Release Suction Cup/Gripper B key 

Chart 12.4 Jog Mode 

Note: If the Joystick cannot control the Dobot Magician after pressing the Logo key, hold the 

Logo key to reset connection. 
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13. Leap Motion Kit 

13.1 Connect the Leap Motion module to the PC through USB cable. 

 

Figure 13.1  Leap motion module 

13.2 Download the Leap motion driver and install it. (Here is the link: 

https://www.leapmotion.com/setup)  

 

https://www.leapmotion.com/setup
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Follow the directions below and keep installing until it’s done.  

 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

121 

 Dobot Magician User Manual 

 

 

Figure 13.2 Successful installation 

13.3 After installing, start up the equipment and open DobotStudio. Click Leap Motion to enter the 

interface: 
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Figure 13.3 Leap motion interface 

13.4 Start: To keep the Dobot stable, turn your palm up to move into controlled area of Leap 

Motion. The Dobot will move accordingly. (Hold hands to trigger the suction cup or gripper.)  

13.5 Turn palm up: remove hand from surveyed area of Leap Motion. 

13.6 Stop: Exit Leap Motion mode. 

13.7 Settings: Set up speed and scale ratio;  

 

Speed：Speed adjustment; 

Scale：Coordinates ratio between leap motion and Dobot;  

Low resource/high resource: Set as low-resource mode for low-performance computers. 
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14. Mouse control 

14.1 The software used for mouse control is DobotStudio. Please open the software and enter into 

mouse module interface, as shown below: 

 

 

Figure 14.1 Enter into mouse controlling interface 

14.2 V key: Start and Stop; 

14.3 Settings: Set up related velocity and acc; 
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Figure 14.2 Parameter settings 

Speed (percentage)：0-100, we suggest 50； 

Scale (percentage): 0-100, we suggest 100; 

We suggest users with a lower performance computer to opt for the low performance option. 

 

Figure 14.3 Parameter settings 

 

Scale X/Y/Z：Scale ratio between mouse coordinates and Dobot coordinates; 

Sample：20-60, depending on PC performance; 

DobotCenter: Keep default settings; 
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15. Blockly 

Dobot Blockly is a programming platform based on Google Blockly. In this process, users can 

program through the puzzle format, which is straightforward and easy to understand. Also, users 

can use the integrated API of Dobot anytime.  

15.1 Blockly Interface 

1. Open DobotStudio and click DobotBlockly: 

 
Figure 15.1 Enter into DobotBlockly 

2. 5 areas are included in this window: 

 
Figure 15.2 DobotBlockly Interface 

Area 1： 

New/Open/Save：New/Open/Save the current files 

Area 2： 

Start/Stop 

Area 3： 
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This part includes the current point location info of Dobot. Log information is in the middle, while 

programming code is on the left:  

 

Figure 15.3 Code information 

Area 4： 

This part has the selection area of blockly module, including logistic, loop, math, Dobot API and 

so on. Just drag them to the window that is OK. 

Dobot API has many functions, such as velocity/acc, end effector settings, move mode, linear or 

jog mode and each interface of I/O configuration. It is very convenient for secondary 

development.  

Area 5： 

Main window of blockly programing 

Area6:  

Home and emergency stop. 

15.2 Blockly Demo 

Here is one basic demo, shown as follows: 

 
Figure 15.4 Programing demo 

Explanation of Demo: Set endeffector as gripper, set the loop number as 3, and make the Z axis 

move back and forth 3 times. After this, click Start, and the Dobot will move accordingly.  
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16. Function Description of LinearRail 

About connecting the rail with Dobot, you can refer to the installation instructions of LinearRail. 

Plug the wires into the base of Dobot after connecting LinearRail with the Dobot. As shown 

below: 

 

Figure 16.1 LinearRail connect to Dobot arm 

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, Color 

sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status indicator 

light is off is when the Dobot is powered down. 
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Figure 16.2 LinearRail wiring diagram 

How to write & draw through the LinearRail: You can use CorelDRAW X7 to transform content 

into PLT format. The software can be downloaded from internet. For more details about software 

operation, refer to the PLT format instructions document. 

 

1. Open DobotStudio, click LinearRail and the button at the right corner of Operation Panel, and 

choose Linear Rail control, as shown below: 

 

Figure 16.3 Click LinearRail 

 

2. After clicking LinearRail, you need to test whether the LinearRail can move properly. Click 

L+ or L-. The Dobot would move left or right. 



Shenzhen Yuejiang Technology Co.,LTD 

 

                                            Shenzhen Yuejiang Technology Co., Ltd 
  

129 

 Dobot Magician User Manual 

 

 

Click Setting and choose Jog to change the velocity and acceleration of the LinearRail. 

Available distance of LinearRail: 0-1000 mm; 

Maximum load: 5kg. 

 

Figure 16.4 LinearRail motion test 
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3. The Dobot needs to reset. Press the Home button before you do anything else. 

Notice: Before you press the Home button, please take the pen off and/or raise the dobot arm 

up. 

 

Figure 16.5 Home test 

 

4. Click Write&Draw after finish homing. 

 

Figure 16.6 LinearRail operation panel 

 

5. Click Open to import the PLT files. 
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Figure 16.7 Import file 

 

6. Click options in the left side of Write&Draw to adjust position and size of characters. 

 

Figure 16.8 Operation Panel 

 

7. Adjust the height of pen, as shown below: 
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Figure 16.9 the height of pen 

 

8. Click AutoZ to save the height of the pen (i.e. keep the position coordinate of Z-axis). 

 

Figure 16.10 AutoZ 

 

9. Click SyncPosition and the Dobot will move to the initial position. 

http://www.baidu.com/link?url=fFhqH_Nu8wc6l1SUvCxx4yPY6dXMvuV6USIHigihhkQdRyt2z11e1lTbnozGIcTUXxV_2ud_lKXUWJ5HaMS_JjAnZ9LNXSeZ6BrcJ0aEDxG
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Figure 16.11 SyncPosition 

 

10. Click Start and the Dobot will write automatically. 

 

Note: If users want to set an action to dip the pen into the ink, please refer to the steps below. It uses 

the Teaching & Playback module. (Everytime you press Unlock Key and then release, the Dobot 

records a point’s position.) 

（1） Set ink dipping position, as shown below, right click blank spaces, and add playback 

triggers. 

A playback trigger causes one ink dipping motion. 

Figure 16.12 Set dip ink position 

（2） Return to Teaching & Playback module to set ink dipping actions. 
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Figure 16.13 Return to Teaching&Playback 

（3） Press the Unlock Key in forearm, move the forearm to the right place, and release the 

Unlock Key to record the first point position. This point position need to be a little high, 

but do not over the limit position. It will prevent the writing brush from touching the 

inkstone. 

 

Follow the following steps for save points. Move the forearm to the related position, and 

use Teaching & Playback to record these points, as shown below: 

 

Figure 16.14 Simulate the actions of ink dipping 

These are the actions to shake off loose ink between the right and left sides. 
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Figure 16.15 Simulate the actions of ink dipping 

Raise the writing brush up to prevent it from touching the inkstone. 

 

Finish recording the ink dipping actions and return to the Write & Draw module to start 

writing in LinearRail. 

 

Notice: The inkstone has its own height, so you need to set a suitable rising height to prevent the 

writing brush from touching the inkstone. (We recommend doing PenUpOffset between 50 to 75.) 
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17. More support 

 For more information,visit http://cn.dobot.cc/ 

 

 For more detailed material about software, second development and any others,visit 

http://cn.dobot.cc/download-center/dobot-magician.html 

 

 Share your idea on Dobot forum http://forum.dobot.cc/ 

 

 Further question, welcome to send email at support@dobot.cc 

http://cn.dobot.cc/
http://cn.dobot.cc/download-center/dobot-magician.html
http://forum.dobot.cc/
mailto:support@dobot.cc
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